GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: Department of Nutritional Sciences

Type of action: |[] [ New course Full online course**

Semester and year course will take effect: Fg|| 2023

New course title: Gut Microbiota and Health

Appropriate computer abbreviation (30 spaces or less): Gut Microbiota and Health
Course instructional methodology: | ecture

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: NTDT 50323/55323

Prerequisites for new course: include an attachment if additional space is needed

BIOL 20234 or BIOL 30304 or permission of instructor

attached files can be seen and managed in Acrobat Pro by clicking on

Click here to attach a file
View > Show/Hide > Navigations Panes > Attachments




Description of new course (catalog copy): include an attachment if additional space is needed

This class will cover the composition and function of the human gut microbiota, its relevance to health, and the
different environmental factors that play a role on its configuration. The class also addresses the gut microbial
changes that have been linked to the incidence of diseases and the potential therapeutics that can be employed to

prevent and/or treat diseases by modifying the gut microbiota. Lastly, antibiotics, antibiotic resistance, and
antibiotic stewardship will be reviewed.

Cilhs e o aitme n 2l attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

Intended outcomes are presented as "Learning Outcomes" in the attached
Syllabus.

attached files can be seen and managed in Acrobat Pro by clicking on

Sliele nsre b9 g @il View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: Elisa Marroquin

Space: Classroom at Annie Richardson Bass Building or Neeley School of Business Building
Equipment: None

Library: None

Financial Aid: None

Other: None

Change in teaching load: NA- The course will replace the course NTDT 50353/55353 in teaching Ic

Does this change affect any other units of the University? Yes || No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Gina Hill

Unit:  Department of Nutritional Sciences

Signature:



Gut Microbiota and Health Syllabus

NTDT 50323/55323

Instructor Name: Elisa Marroquin, Ph.D., M.S.

Semester and Year: Fall 2023

Number of Credits: 3 credits

Class Location: TBA

Class Meeting Day(s) & Time(s): Lecture- MWF (11:00-11:50 am)

Office: Bass 1201G

Office Hours: Mondays 11 am — 5 pm and Wednesdays 11 am to 4 pm

Email: E.Marroquin@tcu.edu

Response Time: Please allow 24-hours for email response on weekdays. Weekend response time will vary.

Important Dates

e Last day to drop: November 7t
e Pass/No Credit (P/NC) date: November 8"

Course Description

This class will cover the composition and function of the human gut microbiota, its relevance to health, and the
different environmental factors that play a role on its configuration. The class also addresses the gut microbial
changes that have been linked to the incidence of diseases and the potential therapeutics that can be
employed to prevent and/or treat diseases by modifying the gut microbiota. Lastly, antibiotics, antibiotic
resistance, and antibiotic stewardship will be reviewed.

Learning Outcomes

Course-Level Learning Outcomes:

1. Describe the composition of the gut microbiota

2. Identify the importance of the gut microbiota for human health

3. Recognize the different factors that play a role in defining the gut microbiota throughout the lifespan

4. Compare the differences in gut and blood microbial composition observed in diseases

5. ldentify the environmental factors that affect the composition of the gut microbiota

6. Analyze the nutritional and non-nutritional therapeutic interventions through which the composition of
the gut microbiota can be modified

7. Recognize the mechanisms of action through which bacteria communicate with each other

8. Explain the mechanisms through which bacteria kill each other

9. Discuss the detrimental effect of antibiotic resistance

10. List the ways to prevent the appearance of antibiotic-resistance

COURSE REQUIREMENTS:

This course currently meets all or part of the following requirements for a degree:

e TCU Core Curriculum Requirement(s): None

e Requirement within the Major: Required for DIET and DPDI majors. Elective option for NUTR majors.
Optional class for MS in NUTR students.

e Requirement for other Majors: None

e Supports Mission Statement: Supports Departmental, College, and University Mission Statements
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Prerequisites

BIOL 20234 or BIOL 30304 or permission of instructor

Required Texts / Materials

A laptop will be needed to take notes and to answer the online exams.

The following eBooks are fully available at no cost at the TCU Library:

Book 1 - Fasano, Alessio, and Susie Flaherty. Gut Feelings: The Microbiome and Our Health,
MIT Press, 2021. ProQuest Ebook Central
https://ebookcentral.proguest.com/lib/tcu/reader.action?doclD=6486639&ppg=1

Book 2 - Health and the Gut : The Emerging Role of Intestinal Microbiota in Disease and
Therapeutics, edited by William Olds, Apple Academic Press, Incorporated, 2014. ProQuest
Ebook Central,
https://ebookcentral.proquest.com/lib/tcu/reader.action?doclD=1693409&ppg=260

Book 3 2 Cossart, Pascale. The New Microbiology: From Microbiomes to CRISPR, ASM Press,
2018. ProQuest Ebook Central
https://ebookcentral.proguest.com/lib/tcu/reader.action?doclD=5473526&ppg=6

Book 4 - Antimicrobial Stewardship : Principles and Practice, CAB International, 2017. ProQuest
Ebook Central

https://ebookcentral.proquest.com/lib/tcu/reader.action?doclD=5897963&ppg=5

You can access to the following articles by copy-pasting the link at the end of each reference or
by downloading them from TCU Online:

Article 1 > Tang, M. and Marroquin, E. Material Obesity Potentially Regulating Offspring’s
Obesity by Acting Through the Gut Microbiota. Accepted for publication in Frontiers in November,
2022

Article 2 > Morales-Marroquin, E., Hanson, B., Greathouse, L., de la Cruz-Munoz, N., &
Messiah, S. E. (2020). Comparison of methodological approaches to human gut microbiota
changes in response to metabolic and bariatric surgery: A systematic review. Obes Rev, 21(8),
e13025. doi:10.1111/0br.13025

https://pubmed.ncbi.nim.nih.gov/32249534/

Article 3 > Arrona Cardoza P, Spillane MB, & Morales Marroquin E. (2021) Alzheimer's disease
and gut microbiota: does trimethylamine N-oxide (TMAO) play a role? Nutr Rev. doi:
10.1093/nutrit/nuab022. PMID: 33942080.

https://pubmed.ncbi.nim.nih.gov/33942080/

Article 4 = Luciana Princisval, Fernanda Rebelo, Brent L Williams, Anna Carolina Coimbra,
Louise Crovesy, Ana Lorena Ferreira, Gilberto Kac, Association Between the Mode of Delivery
and Infant Gut Microbiota Composition Up to 6 Months of Age: A Systematic Literature Review
Considering the Role of Breastfeeding, Nutrition Reviews, Volume 80, Issue 1, January 2022,
Pages 113-127, https://pubmed.ncbi.nim.nih.qgov/33837424/
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o Article 5 > Pfefferle Pl, Keber CU, Cohen RM, Garn H. The Hygiene Hypothesis - Learning From
but Not Living in the Past. Front Immunol. 2021 Mar 16;12:635935. doi:
10.3389/fimmu.2021.635935. PMID: 33796103; PMCID: PMC8007786.
https://pubmed.ncbi.nim.nih.gov/33796103/

e Article 6 > Goraya MU, Li R, Mannan A, Gu L, Deng H, Wang G. Human circulating bacteria and
dysbiosis in non-infectious diseases. Front Cell Infect Microbiol. 2022 Aug 24;12:932702. doi:
10.3389/fcimb.2022.932702. PMID: 36093202; PMCID: PMC9448904.
https://pubmed.ncbi.nim.nih.gov/36093202/

e Article 7 > Fernandez-Alonso M, Aguirre Camorlinga A, Messiah SE, Marroquin E. Effect of
adding probiotics to an antibiotic intervention on the human gut microbial diversity and
composition: a systematic review. J Med Microbiol. 2022 Nov;71(11). doi: 10.1099/jmm.0.001625.
https://pubmed.ncbi.nim.nih.gov/36382780/

e Article 8 > Morales-Marroquin, E., Xie, L., Uppuluri, M., Almandoz, J. P., Cruz-Mufoz, N., &
Messiah, S. E. (2021). Immunosuppression and Clostridium difficile Infection Risk in Metabolic
and Bariatric Surgery Patients. Journal of the American College of Surgeons, S1072-
7515(21)00342-2. Advance online publication. doi.org/10.1016/j.jamcollsurg.2021.04.028
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC8316288/

Teaching Philosophy

It is the desire of the faculty in the Department of Nutritional Sciences (NTDT) to help students achieve their
fullest potential in acquiring knowledge and developing skills for professional applications in nutrition and
dietetics practice. Providing students with access to a wide variety of learning experiences supports different
learning styles and creates an opportunity for individual discovery and synthesis of knowledge related to the
science of nutrition. The role of the NTDT faculty is to provide students with tools that foster self-discovery and
professional development, result in the acquisition of knowledge from evidence-based research, and cultivate
life-long learning.

| enjoy providing students with the most up-to-date scientific knowledge to enable them to have access to the
latest preventive/therapeutic information in the field. Furthermore, | love showing students how to find scientific
information by themselves to facilitate their independent knowledge acquisition in the future. My role is to
educate students on the most important aspects pertaining to the gut microbiota and its involvement in human
health, as well as to teach the students how they can remain updated in this ever-changing scientific field.

- Dr. Marroquin

Instructional Methods

Most of the classes will be imparted by the professor, however, a couple of classes (indicated in the schedule)
will be imparted by the graduate students taking the class.

Students are expected to read the assigned chapters or articles before each of the classes, participate in
classes and fully engage with the provided materials for improved learning.

Course Policies and Requirements
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Exams. Both will be taken online, in the classroom, at the time of the specified class, using Respondus and
Lockdown. If you have special accommodations email me at the beginning of the semester to make sure |
schedule these two exams at the testing center.

Class Summaries. Students are expected to come to class prepared by reading the assigned chapters and/or
articles ahead of each of the classes and by taking notes in the form of abstracts (with students’ words, not
copy/pasted), etc. Students should work on one abstract, of at least one page, per class. Each of these
abstracts should have a subtitle indicating the Book Chapter Number or the Article Reference. At the end of the
semester all abstracts will be merged into an individual PDF which will include a title page and a table of
contents. This is the PDF that will be submitted. A PDF without subtitles will be subject to a 50%-grade
reduction. The final PDF document will be due at the end of the semester (see schedule). Documents will be
evaluated for plagiarism.

Graduate Student Presentations. During the first day of classes, graduate students will be randomly
assigned a research article that they will have to read and present in class. Students are encouraged to include
images, figures, and tables from the original article and to showcase their deep understanding of the topic.
Reading additional sources might be necessary to understand the article and to respond to potential questions
during class. Presentations should have a duration of 30 min plus 15 minutes of questions from the professor
and the rest of the class. Students are expected to answer those questions, and part of their grade will reflect
their ability to create cohesive and articulated answers to these questions. The presentation should be posted
prior to 10 am of the corresponding class day (which will differ by student). The rubric to evaluate presentations
will be posted on TCU Online.

Final Research Project. All students will select a nutrition topic of their choice and will conduct an in-depth
literature research in the area. Evaluation of their literature research will be performed by creating a document
and a presentation. Document: 3-page word document (Times New Roman 12, single space), with citations in
numbered style and an additional title page, as well as using at least 5 scientific articles as references.
Presentation: 10-20 min presentation per person (depending on the number of students). Unlimited number of
slides, use limited text and abundant images, tables, and graphs. Grammar will be evaluated in both the
document, and the presentation. A rubric with instructions will be posted on TCU Online.

Grading
NTDT 50353 (Undergraduate Students)
Assignments, Exams, Presentations, etc. Points

Two non-cumulative exams (15 points each) 30
Final Research Project 30
Class Summaries (35 summaries x 0.57 points each) 20
Final Exam 20

100
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NTDT 55353 (Graduate Students)
Assignments, Exams, Presentations, etc. Points

Two non-cumulative exams (15 points each) 30
Graduate Student Presentations 20
Final Research Project 30
Class Summaries (35 summaries x 0.57 points each) 20
Final Exam 20

120

All course assignments are mandatory and must be completed in order to pass the course with a C or above.

Note: For students enrolled in the MS in Dietetics program, all final 50000 and 60000 level course grades
will be included in the computation of the graduate GPA, but no more than two grades of “C+” or lower

may be utilized in satisfying the degree requirements.

Grading Scale — Undergraduate Students

Grade Score

A 90-100

B 80-<90 This class does not employ the +/- grading system.

Grades are rounded to the nearest whole number.
C 70-<80 (For example, 89.5% is rounded up to 90%, which is
an A. 89.4% is rounded down to 89%.)

D 60—<70

F <60

Grading Scale — Graduate Students

Grade Percentage Points
A 90-100 108-120
B 80-<90 96-<108
C 70-<80 84-<96
F <70 <84

This class does not employ the
+/- grading system.
Grades are rounded to the
nearest whole number.
(For example, 89.5% is rounded
up to 90%, which is an A. 89.4%
is rounded down to 89%.)
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Late Work:

All assignments are due by the beginning of the class on the assigned day. Late assignments are not allowed
unless they are considered Official University Absences, serious iliness, or family-related emergencies verified by
the Dean of Students. Each day of late work will decrease the maximum achievable grade by 20%.

Spelling & Grammar:

NOTE: Correct spelling and grammar is expected for ALL course assignments and activities and required for
full points. Up to 30% of the final assignment grade will be deducted depending on the number of grammar and
spelling errors. TCU provides extensive resources, including the Writing Center. Additionally, there are
extensive technology resources to help students catch and correct improper spelling and grammar.

Grading Concerns:

If you have concerns about a grade, please email me. We may meet and discuss the grade or communicate
about it via email.

Participation & Attendance Policy:
Students are expected to participate in all course activities. Attendance for ALL classes is mandatory. Students
must read assigned chapters and articles to adequately prepare for course discussions.

The University Attendance Policy states that regular and punctual class attendance is essential and that no
assigned work is excused because of absence, no matter the cause.

Students frequently ask, “What do | do when | miss a class?” The University’s policy on class attendance

is clear and straightforward. Regular and punctual class attendance is essential, and no assigned work is
summarily excused because of absence, no matter what the cause. Records of class attendance are the
responsibility of the faculty. Students who miss an instructional experience are expected to meet with faculty to
discuss their absence as soon as possible.

Class Norms & Netiquette:

All members of the class are expected to be respectful and to follow rules of common courtesy in all email
messages, discussions, and chats. If | deem any of them to be inappropriate or offensive, | will forward the
message to the Chair of the Department and appropriate action will be taken, not excluding expulsion from the
course. The same rules apply online as they do in person. Be respectful of other students. Foul discourse will
not be tolerated. Please take a moment and read the basic information about netiquette
(http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites sometimes used for
educational collaborations, should be done with honor and integrity. Please review TCU’s guidelines on
electronic communications (email, text messages, social networks, etc.) from the Student Handbook.
(https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-networks/)

Email:

Only the official TCU student email address will be used for all course notification. It is your responsibility to
check your TCU email on a regular basis.
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Course Materials:

TCU students are prohibited from sharing any portion of course materials (including videos, PowerPoint slides,
assignments, or notes) with others, including on social media, without written permission by the course
instructor. Accessing, copying, transporting (to another person or location), modifying, or destroying programs,
records, or data belonging to TCU or another user without authorization, whether such data is in transit or
storage, is prohibited. The full policy can be found at: https://security.tcu.edu/polproc/usage-policy/.

Violating this policy is considered a violation of Section 3.2.15 of the Student Code of Conduct (this
policy may be found in the Student Handbook at https://tcu.codes/code/index/), and may also constitute
Academic Misconduct or Disruptive Classroom Behavior (these policies may be found in the
undergraduate catalog at https://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details). TCU encourages student debate and discourse; accordingly, TCU
generally interprets and applies its policies, including the policies referenced above, consistent with the values
of free expression and First Amendment principles.

Technology in the Classroom

e Personal computers/laptops are allowed in the lecture classroom for note-taking only (notifications
should be runed off!).

e Cell phones should be turned off during class.

o Students should not be texting or accessing any social media, email or other electronic communication
during class using a cell phone, laptop or classroom computer. Classroom computers are to be used only
for activities associated with the class. If the instructor considers a student’s use of a cell phone or
computer inappropriate and/or disruptive, the student may be asked to leave the classroom. Also, cell
phones, PDA’s and recording devices are not to be used or visible during an exam.

Exams

o All exams will be administered in computerized format in person, in the classroom, during class time, using
the Respondus Lockdown Browser and Monitor.

¢ |tis the student’s responsibility to make sure their device meets the software requirements for the
Respondus Lockdown Browser and Monitor.

o Students will only be allowed to make up exams that they miss due to Official University Absences, serious
illness, or family-related emergencies verified by the Dean of Students.

e Students should notify the instructor as soon as possible and the instructor must receive written verification
of Official University Absences from the Dean of Students prior to the make-up exam or homework.

e Students will be allowed to view their exam results after the exam has been taken by all members of the
class. The student may not copy any questions or answers from the exam. Students should make an
appointment with the instructor to view a completed exam.

¢ Simple math calculators may be used for exams when indicated. Calculators that are programmable or
have memory are not allowed. Cell phones may not be used as a calculator.

e Students should not utilize cell phones during exams.

Using LockDown Browser for Online Exams
This course requires the use of LockDown Browser for online exams.
e Watch this short video to get a basic understanding of LockDown Browser and the optional webcam
feature (which may be required for some exams).
¢ Then download and install LockDown Browser from this link:
e http://www.respondus.com/lockdown/download.php?id=957434800
e NOTE: Respondus products do not work on Chromebooks.
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To take an online exam, Start LockDown Browser, log into TCU Online, and select this course. Then
navigate to the exam. (You won't be able to access the exam with a standard web browser.) For
additional details on using LockDown Browser, review this Student Quick Start Guide (PDF).
Finally, when taking an online exam, follow these guidelines:

o Turn off all mobile devices, phones, etc. and clear your desk of all external materials

o Remain at your desk or workstation for the duration of the exam

o LockDown Browser will prevent you from accessing other websites or applications; you will be

unable to exit the exam until all questions are completed and submitted

Academic Misconduct:

Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates the academic
integrity of the institution is considered academic misconduct. The procedures used to resolve suspected acts
of academic misconduct are available in the offices of Academic Deans and the Dean of Students and are
listed in detail in the Undergraduate Catalog and the Graduate Catalog Specific examples include, but are not
limited to:

Cheating: Copying from another student’s assignments or quizzes; collaborating with or seeking aid
from another student during a quiz; knowingly using, buying, selling, stealing, transporting, or soliciting
in its entirety or in part, the contents of a test or other assignment unauthorized for release; substituting
for another student or permitting another student to substitute for oneself.

Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s work, and the
unacknowledged submission or incorporation of that work as one’s own offered for credit. Appropriation
includes the quoting or paraphrasing of another’s work without giving credit therefore. Turnitin will be
used in this course as part of the TCU Online assignment submission process. Turnitin may also be
used for other plagiarism detection.

e Turnitin will be used to evaluate how much of the content is original content. If greater
than 20% of either assigned paper is not original (excluding the reference list), you will
be required to rewrite the paper and will receive 50% off of the final grade. You are
encouraged to check your papers before submission.

Collusion: The unauthorized collaboration with another in preparing work offered for credit.

Abuse of resource materials: Mutilating, destroying, concealing, or stealing such material.
Computer misuse: Unauthorized or illegal use of computer software or hardware through the TCU
Computer Center or through any programs, terminals, or freestanding computers owned, leased or
operated by TCU or any of its academic units for the purpose of affecting the academic standing of a
student.

Fabrication and falsification: Unauthorized alteration or invention of any information or citation in an
academic exercise. Falsification involves altering information for use in any academic exercise.
Fabrication involves inventing or counterfeiting information for use in any academic exercise.
Multiple submission: The submission by the same individual of substantial portions of the same
academic work (including oral reports) for credit more than once in the same or another class without
authorization.

Complicity in academic misconduct: Helping another to commit an act of academic misconduct.
Bearing false witness: Knowingly and falsely accusing another student of academic misconduct.

TCU Online: Our Learning Management System

Getting Started with TCU Online

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)

1.

Access via my.tcu.edu > Student Quick Links > TCU Online
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2. Login at the following website (http://d2l.tcu.edu) my.tcu.edu

*For information about logging into TCU Online, view these instructions. (http://tcuonline.tcu.edu/kb/how-do-i-
log-in/).
Student Orientation Tutorial for TCU Online:

If you have not yet taken the TCU Online Student Orientation Tutorial, please do so now. To access it, click on
the Orientations semester OR view all courses in your My Courses widget visible upon logging in to TCU
Online. Click on the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

How This Course Will Use TCU Online:

This course will use TCU Online extensively. All lectures and assignments’ instructions will be available
through the designated modules in the “Content” section. Assignments and Lab Reports will be submitted in
the “Activities” > “Assignments” area. The Food Science Research Project Presentations will be viewed in the
“Activities” > “Discussions” section; Research Project Reflection Posts will be submitted to the “Discussions”
section as well. Grades and feedback will be posted in the “Assessment” 2> “Grades” section.

Getting Help with TCU Online

If you experience any technical problems while using TCU Online, please do not hesitate to contact the TCU
Online (D2L) Help Desk. They can be reached by phone or chat 24 hours a day, 7 days a week, 365 days a
year.

Phone: 1-877-325-7778
Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the Help Desk to resolve a technical issue, make sure to keep me updated on the
troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please contact me.
Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you will login to TCU
Online and select your name on the top right of the screen. In the Profile area, you can upload a photo of
yourself and add personal information. In the Notifications area, you can add your phone number to receive
text messages when grades are given as well as reminder texts for upcoming assignments and quizzes.

Student Success Tools for TCU Online:
Pulse:

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the number of
assignments and events on the course calendar for your classes, the graph will display busy times for class
work in the upcoming week. You can use this app to manage your daily workload, and it includes the ability to
view and access course materials offline. You can download Pulse from the Google Play or Apple Store. You
can learn more and download Pulse here:_htips://www.d2l.com/products/pulse/.

ReadSpeaker:

ReadSpeaker includes a number of tools that can enhance your understanding and comprehension of course
materials. ReadSpeaker can create an audio version of content that you can listen to while on a page within a
course or that you can download to listen offline. ReadSpeaker can also read Microsoft Office files and PDFs.
There are additional tools and features to assist you with reading and focusing in TCU Online, tools that
provide support for writing and proofing text, and tools that can read non-TCU Online content aloud. You can
learn more about how to use ReadSpeaker tools here: htips://tcuonline.tcu.edu/how-to-hub/instructor-how-to-
hub-for-tcu-online/integrations-and-mobile/readspeaker/
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Support for TCU Students

Campus Offices

e Academic Advising (817-257-7486, Jarvis 104)

o Brown-Lupton Health Center (817-257-7938 or 817-257-7940)

e Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
e Center for Writing (817-257-7221, Reed Hall 419)

e Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2™ floor)

o Dean of Students (817-257-7926, the Harrison 1600)

e Mary Couts Burnett Library: Reference Desk (817-257-7117)

¢ Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 15t floor)

o Student Access & Accommodations (817-257-6567, The Harrison 1200)
e Student Success (817-257-8345, Samuelson Hall, West Entrance)

e Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2" floor)
e Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
e Veterans Services (817-257-5551, Jarvis Hall 2" floor)

Anti-Discrimination and Title IX Information
Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from unlawful
discrimination, harassment, sexual misconduct, and retaliation. In support of this commitment, in its policy on
Prohibited Discrimination, harassment, sexual misconduct and retaliation, TCU has a range of prohibited
behaviors, including unlawful discrimination and harassment and related sexual and other misconduct based
on age, race, color, religion, sex, sexual orientation, gender, gender identity, gender expression, national
origin, ethnic origin, disability, predisposing genetic information, covered veteran status, and any other basis
protected by law. The Office of Institutional Equity (OIE) is responsible for responding to all reports of
discrimination, harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment, Sexual
Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of Prohibited Discrimination,
Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email cie@tcu.edu, visit us at The Harrison, Suite 1800
or click here: Make a Report.

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click here:
https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU'’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU’s Title IX Coordinator. You
may call 817-257-8228 to make a report, email oie@tcu.edu or a.vircks@tcu.edu, or make a report here.
Additional Title IX resources and information are available at https://www.tcu.edu/institutional-equity/title-

ix/index.php.
Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters. Mandatory
reporters are required to immediately report to OIE any conduct that raises Discrimination, Harassment, Sexual
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Misconduct (Title IX or Violence Against Women (VAWA)) or Retaliation. Mandatory reporters cannot promise
to refrain from forwarding the information to OIE.

Confidential On-Campus Resources
Campus Advocacy, Resources & Education
www.care.tcu.edu | 817-257-5225
Counseling & Mental Health Center

www.counseling.tcu.edu | 817-257-7863

Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On Campus Resources
TCU Police
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays:

“Students who are unable to participate in a class, in any related assignment or in a university required activity
because of the religious observance of a holy day shall be provided with a reasonable opportunity to make up
the examination or assignment, without penalty, provided that it does not create an unreasonable burden on
the University.” For more information, please visit the TCU Policy for Religious Observations & Holidays
webpage.

Student Access and Accommodation:

Texas Christian University affords students with disabilities reasonable accommodations in accordance with
the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. To be eligible for disability-related
academic accommodations, students are required to register with the TCU Office of Student Access and
Accommodation and have their requested accommodations evaluated. If approved for accommodations,
students are required to discuss their official TCU Notification of Accommodation with their instructors.
Accommodations are not retroactive and require advance notice to implement. The Office of Student Access
and Accommodation is located in The Harrison, Suite 1200. More information on how to apply for
accommodations can be found at https://www.tcu.edu/access-accommodation/ or by calling Student Access
and Accommodation at (817) 257-6567.

Audio Recording Notification:

Audio recordings of class lectures have to be permitted by the instructor. Recordings are not to be shared with
other students, posted to any online forum, or otherwise disseminated.

Emergency Response Information:

View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek Shelter
procedures. (https://publicsafety.tcu.edu/less-is-more/)

View the TCU Building Safety Maps that show the specific seek shelter locations and building rally points for
evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)
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View the TCU Evacuation Rally Point Map to see all rally points for evacuation.
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)

Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/).
In the event of an emergency, call the TCU Police Department at 817-257-7777.

Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking to complete your SPOT for this course. |
appreciate your thoughtful and reflective feedback to help make this course successful for future students. You
can fill out the SPOT by clicking on the link in the email or in TCU Online when SPOTs open. SPOT feedback
is used to develop and improve the course each semester. Each comment is read and considered.

TCU Mission Statement

To educate individuals to think and act as ethical leaders and responsible citizens in the global community.

Mission of the Department of Nutritional Sciences: To support the mission of the University, college and
programs within the department and to provide a distinctive program of study in all areas of nutrition and
dietetics within a liberal arts setting. The faculty of the Department affirm their commitment to the education of
broadly informed, scientifically competent, self-educating, and ethically responsible citizens who are capable of
entering successful careers in food science, nutrition, and dietetics and are also cognizant of the needs of the
community and society at large.
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Fall 2023

Gut Microbiota and Health Course Calendar - NTDT 50323/55323

This calendar represents the current plans and objectives. As we go through the semester, those plans may
need to change to enhance the class learning opportunities. Such changes will be clearly communicated.

Date Mondays Wednesday Friday
Week 1: | - Class Introduction Readings (Class Summary 2): Readings (Class Summary
Aug 21- | - Review of Syllabus and “Gut Microbiota in Sickness and 3):
25 Schedule Health” “The Microbiome and Gut
- Distribution of graduate Chapter 2 (Book 2) Inflammatory Disorders”
students presentations Chapter 7 (Book 1)
- Email Accommodations to
Reading (Class Summary Professor as exams have to be
1): scheduled at the testing center at
“Bacteria: Many Friends Few | the beginning of the Spring 2023
Enemies” semester.
Chapter 1 (Book 3)
“Nutrition, Microbiomes, and
“Bacteria: Highly Organized Intestinal Inflammation”
Unicellular Organisms” Chapter 1 (Book 2)
Chapter 2 (Book 3)
Week 2: | Readings (Class Summary | Readings (Class Summary 5): Readings (Class Summary
Aug 28- | 4): “The Microbiome and Obesity” 6):

Sept 1 | “Increased Gut Permeability Chapter 8 (Book 1) “Microbial Reprogramming
and Mesenteric Fat Inhibits Western Diet-
Inflammation” Associated Obesity”
Chapter 4 (Book 2) Chapter 3 (Book 2)

Week 3: | Labor Day Readings (Class Summary 7): Readings (Class Summary
Sept 4-8 “Transgenerational Transmission | 8):
of Obesity Through the Gut “The Microbiome and
Microbiota” Autoimmunity”
Article 1 Chapter 9 (Book 1)
(1%t graduate student
presentation)
Week 4: | Readings (Class Summary | Readings (Class Summary 10): | Readings (Class Summary
Sept 11- | 9): “The Microbiome and 11):
15 “The Microbiome and Cancer | Environmental Enteropathy” “Gut Microbiology and Bariatric
Chapter 12 (Book 1)’ Chapter 11 (Book 1) Surgeries”
Article 2
(2" graduate student
presentation)
Week 5: | Readings (Class Summary | Readings (Class Summary 13): | Readings (Class Summary
Sept 18- | 12): “Microbiota and Healthy Aging” 14):
22 “The Microbiome and Chapter 12 (Book 2) “Gut Microbiota and Alzheimer
Neurological and Behavioral Disease”
Disorders” “Maintaining a Healthy Gut Article 3

Chapter 10 (Book 1)

Microbiome Through Old Age”
Chapter 18 (Book 1)

(3 graduate student
presentation)
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Date Mondays Wednesday Friday
“Microbiome Research in Gut
Brain Axis Diseases:
Psychobiotics”
Chapter 16 (Book 1)
Week 6: | Readings (Class Summary | Readings (Class Summary 16): | Exam 1
Sept 25- | 15): “Diet-Microbiota Interactions and
29 “Impact of Synbiotic Food on | their Implications for Healthy
the Gut Microbial Ecology Living”
and Metabolic Profiles” Chapter 10 (Book 2)
Chapter 9 (Book 2)
Week 7: | Readings (Class Summary | Readings (Class Summary 18): | Readings (Class Summary
Oct2-6 | 17): “Gut Pharmacomicrobiomics: The | 19):
“Prebiotics, Fecal Tip of an Iceberg of Complex “Fame and Future of Fecal
Transplants and Microbial Interactions between Drugs and Transplantations: Developing
Network Units to Stimulate Gut-Associated Microbes” Next-Generation Therapies
Biodiversity of the Human Chapter 13 (Book 2) with Synthetic Microbiomes”
Gut Microbiome” Chapter 14 (Book 2)
Chapter 11 (Book 2)
“Treatments for Disease:
Prebiotics, Probiotics,
Synbiotics, and Postbiotics”
Chapter 15 (Book 1)
Week 8: | Readings (Class Summary | Readings (Class Summary 21): | Fall Break
Oct 9-13 | 20): “Hygiene Hypothesis”
“Effect of Delivery Mode and | Article 5
Breastfeeding on the Gut (5" graduate student
Microbiota” presentation)
Article 4
(4" graduate student
presentation)
Week 9: | Readings (Class Summary | Readings (Class Summary 23): | Readings (Class Summary
Oct 16- | 22): “Biofilm: When Bacteria Gather 24):
20 “Blood Microbiota” Together” “When Bacteria Kill Each
Article 6 Chapter 6 (Book 3) Other”
(6" graduate student Chapter 8 (Book 3)
presentation) “How Bacteria Communicate:
Chemical Language”
Chapter 7 (Book 3)
Week | Readings (Class Summary | Readings (Class Summary 26): | Readings (Class Summary
10: 25): “Pathogenic Bacteria, Major 27):
Oct 23- | “Human- Animal Symbioses: | Scourges, and New Diseases” “The Multiple Strategies of
27 The Microbiotas” Chapter 12 (Book 3) Pathogenic Bacteria”

Chapter 9 (Book 3)

“Endosymbiotic Relationship”
Chapter 11 (Book 3)

Chapter 13 (Book 3)

“New Visions on Infectious
Defense”
Chapter 16 (Book 3)
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Date Mondays Wednesday Friday
Week | Readings (Class Summary | Readings (Class Summary 29): | Readings (Class Summary
11: 28): “Clinical Perspectives on 30):
Oct 30- | “Antibiotic Resistance” Antimicrobial Stewardship” “Mechanisms of Resistance
Nov 3 | Chapter 5 (Book 3) Chapter 2 (Book 4) to Antibacterial Agents”
Chapter 5 (Book 4)
“Principles of Antimicrobial “The Importance of Education in
Stewardship” Antimicrobial Stewardship”
Chapter 1 (Book 4) Chapter 4 (Book 4)
Week | Readings (Class Summary | Readings (Class Summary 32): | Readings (Class Summary
12: Nov | 31): “Colonization and its Importance | 33):
6-10 “Antimicrobial Resistance: for the Emergence of Clinical “Antibiotic Resistance:
Selection versus Induction” Resistance” Associations and Implications
Chapter 6 (Book 4) Chapter 7 (Book 4) for Antibiotic Usage Strategies
to control Multi-resistant
Bacteria”
Chapter 8 (Book 4)
Week | Readings (Class Summary | Readings (Class Summary 35): | Exam 2
13: Nov | 34): “Immunosuppression and
13-17 | “Effect of Adding Probiotics to | Clostridium difficile infection”
Antibiotic Interventions” Article 8
Article 7 (8" graduate student
(7" graduate student presentation)
presentation) Class Summaries Due
Week | Thanksgiving Thanksgiving Thanksgiving
14:
Nov 20-
24
Week Gut Microbiota Final Gut Microbiota Final Gut Microbiota Final
15: Research Project Due Presentations - Student 4-6 Presentations - Student 7-9
Nov 27- | (everyone)
Dec 1
Gut Microbiota Final
Presentations - Student 1-3
Week | Gut Microbiota Final Gut Microbiota Final Study day (no classes)
16: Presentations - Student 10- | Presentations - Student 13-15
Dec4-8 | 12
Week
17 Final Exam (Cumulative)
Dec 11- Day: TBD
15 Time: TBD

Location: TBD
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